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|1.z |25

[7] 1gnore Orientation

Scope To [Object Faces and Edges

z)

Object Type _
Geom [ |Mesh

Selections | rest

Create |

(Delete ] write...] [Read...]

Compute [ Filters...

[Delete size Field | |
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AR

Scoped Sizing

air_channels
engine_transmisssion
externall

external?

fan

hx

mrf

rest

spoiler1

spoiler2

spoiler3

tires
tunnel-boundaries
tunnel_inlet

ub

(=]

Scoped Sizing List [E] [=] [&] Global Scoped Sizing

Min Max

Growth Rate

|u.5 1024

12

Local Scoped Sizing

|u.5 |2

arne Type
H side_plate | curvature A
Min Max Face Proximity Opkion

[]Face Boundary

Growth Rate  MNormal Angle [ ] 1gnore Self

[V]Face Face

| 12 | 18 [¥] 1gnore Orientation
Zells Per Ga

3 -
Scope

Scope To [Face Zone

Object Type

Geom Mesh

Selections |zone8130213.prt:8130213.prt—so [ee:)

Create

[Draw | [Delete | [write... | [Read... |

] [ Fiters.. | [DeletesizeField| |

Cose | [ hep |
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lobal Scoped Sizing

N REE
> Lk

GrowthRate

ocal Scoped Sizing

Name. Type

o e [spotert ‘ arvature

ace Proxinity Cption
spoiler2. T"‘: TB“: ] Foce Bourdk
eholers T s ace Boundary
tires s [VIFace Face
el boundaries GrowthRate Normal Angle | [

Growth Rate Nomnal Angle | [ sgnore self
tunel inlet
i 12 8 [Z]1gnere Orientation

Cells Per Gay
|
=)

Scope

e —

[Delete Size Field |

[

— 1D

AR S e R

86

Growth Rate

ocal Scoped Sizing

<poller3

res
tunnel-boundaries
tunnel inlet

ub

[spoter2 | curvature -

ace Proxinmity Option

[7IFace Face
Growth Rate Normal Angle

[I1gnore seif
R i~
Cells Per G:
3 &)
B

ScopeTo |ace Zone -

Object Type

SSICtONS [soned 130215 pria 10215 prio [

(5)(=) () Global Scoped Sizing

M Max
lengine_transmisssion

i 05 024 12
fan

Growth Rate

Name.

o

bres
tunnelboundaries
ftunnel inlet

ub

=
[ ol
o o i

Ere—) |05 [ | Lrecsansy

GrowthRate  Narmal Angle
2

ol Per Gay

sce Proxinity Option

[/]Face Face
[tgnore seff
[/ 1gnore Orientation

[Ccompe ] [ Fiters.. ] [peletesiere] [ Gom ]

37



ANSYS = R B2 Hi A

qy==
ik
(e
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ctions:

view auto
view auteo

ne/object-edges)

TR

Scoped Sizing

F Y .

tunnel_inlet
ub

coped Sizing List (E) () (&) Global Scoped sizing
air_channels Min Max Growth Rate
engine_transmisssion =T
external1 E o2
external2 L
hﬁ;(” Local Scoped Sizing _
mrf Name Type
rest =
side_plate | tires curvature Z:
== Co——
spoiler3 2 8 Face Boundary

Face Face
tunnel-boundaries Growth Rate Normal Angle Ignore Self

12 8 Ignore Orientation

write... ] (Read..,

[ e
=
| semeo
Object Type
‘@Geom [CImesh ‘

Selections [70ne4934084.prt:4934084.prts0 [e. |

ANSYS Fluent Meshing Release 16

Create

Compute Filters...

AR S e R

DAY

Delete Size Field | [ Close. ] [L__ Hep. |
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Scoped Sizing

Scoped Sizing List

[ (=) (&) Global Scoped Sizing

air_chamnels
lengne_iransmisssion
extemall

extemal2

Min Max
0.5 1024

Growth Rate

12

ocal Scoped Sizing

Name

Type

tunnek-boundaries soft -
|

Cells Per Gap
I
=

cope

Object Type
eom [1/)

Selections [y nel-ymax tunnel-zmax tunnel-: E]

[create]

| [Dekete SzeFidd] [ dose

J [ re ]

l,ﬁ'

f el

side_plate

x:}:g ace Froximity Option [—

spoler3 [ JFace Boundary [T]Face Face

tires [“IFace Face ore Seff
Growth Rate Normal Angle [1gnore self B

tunne inlet M2 s [71ignore Crientation

ub [/]1gnore Orientation B
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> AR

Scoped Sizing List [E) (5] &) Global Scoped Sizing

air_channels Min Max Growth Rate
engine_ransmisssion

externall | 0.5 | 1024

external2

|12 Apply | [Reset

Local Scoped Sizing

mrf Tlarne Type
rest
b tur
side_plate || u ‘ curvature -
ﬁ::g; Min Max Face Prozximity Option
spoiler3 | 2 | 0 []Face Boundary
tires ) |:| Face Face
E::::-tﬁ:?danes Growth Rate MNormal Angle [ ] 1gnore Self
|12 |8 [/ tgnore Orientation
Cells Per Gap
|73 -
i
Scope

Scope To [Object Faces and Edges 7|

Object Type

Geom Mesh

Selections | ub

Create

[Oraw] [Delete | [wirite... | [Read... |

[ Compute | [ Fiters.. | [Deletesiz=Field| |

Close

J e |
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=R ATALE

M T AEE

TR
> RS N“worldcar_sizingl.msh.gz”
> Hnotepad++F] H A “AdvWrapNPrisms_R16R17_v814 Userlnputs.scm”

> RN LT 44 7B “worldcar_sizing1”
> fRAFscheme WV {4

; == USER INPUTS

N s L R

. T TS U

[SIT-Re)

(define input geometry

rldecar sizingl™)

;It will read <input_geometry>.msh.gz

(define compute size field "yes")

;If "no", it will read <input_geometry>-initial.sf for wrapping and <input geometry>-target.sf for surface r
;If yes, it will compute size field using <input geometry>-initial.szcontrol for wrapping and <input_geometr

(define initial over target size ratio 0)

;If initial target_size ratio is set as 0, it will use <input_ geometry>-target.szcontrol for surface remesh.
;If initial target_size ratio is set as 1, it will use <input_geometry>-initial.szcontrol for surface remesh
;If initial target_size ratio is set greater than 1, it will use initial target size ratio * <input_geometry

;IMPCRTENT: For complex

models, the initial size cannot be too different from target size -- surface remesh

> IN#EE A A “AdvWrapNPrisms_R16R17_v814 Main_Load.scm” |Fluent
MeshingiB i File=>Read=>Scheme

worldcar_sizingl Fluent@punrvsonawapcwin.ansys.com [3D, serial]

A

AR S e R

File § Bounda Mesh  Display Report View Help

Read 4 Mesh...

Write » Tesm.

Import » Boundary Mesh...

Save Picture... Size Field...

Exit Scheme...
Journal...

- 6 hx )

Domains...

- i@ mrf
- I rest
- B tunnel

@ ub
B8 Mesh Objects
=~ Unreferenced
Egp Edge Zone

waorldcar_sizingl
worldear
test_prism_bracket_solo_v3_surface

test_prism_bracket_solo_v3

iy Face zones () ]

U3
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v'Scheme X 472 AK€ X Rl B BiBOIX B

j========—==yiger input for refinement regions
(define exclude zones "tunnsl*")
(define zones_to offset ' (

N

rRefinement Zone BL BL BL Wake Total Wake Cross-Wake
:Region Name List Height Divisions Min 3F Expansion Divisions Total Expansion
; Factor Factor
("_bod_full"™ e 192 1 48 2 i 1.5)

1

(define upstream bol min size 24)

(define upstream bol lewels 2)

(define upstream boi_height_2_expansion_ratio 1)

(define RefinementRegicnGrowthRate 1.35)

;Uzage: During size controls definition, type: generate bois

L
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ANSYS & B 2= e wy Ab

m RS REL
> i N Scheme U &K
v ¥THFAdvWrapNPrisms_Rxx_v814_ AdvSettings.scm
v {BIBOIK B

y==========\13er 1input for refinement regions
(define exclude zcones "tunnel*”)
(define zones_to offset '

b

Eefinement Zone BL BL BL Wake Total Wake Cross-Wake
;Begion Name List Height Divisions Min SF Expansion Divisions Total Expansion
: Factor Factor
("_boi_full"™ 254 3 a4 B i 2.2)

1
(define upstream boi min size Z4)

(define upstream bol levels o)

(define upstream boi height Z expansion ratio 1)

(define RefinementRegionGrowthRate 1.3)
;Usage: During size controls definition, type: generate bols

v LRAF-Scheme X A

L)
7 AN “IDAJ-China EANSYSHEIR 2 & fE Ik
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ANSYS & B 2= e wy Ab

B RS EREL

> T E
v A§ FHTUI% A\ “generate_bois” , 7F 4 & [F 612 BOIs

Loading "E:%2016\Mohib\3VW_worldcar adv_wrapper workshop'\RdvWrapNFrisms R16R17 w814 Main Load.scm"
Fast-loading ".“AdvWrapWNPrisms_R16R17_w&14 Main.bin"

Loading ".%.\AdvWrapNPFrisms R16R17_wv&1l4 UserInputs.scm”

Done.

Loading ".%.\AdvWrapNFrisms R16R17_wv814 AdvSettings.scm”

Done.

Done.

Done.

{0

Meshing> generate_bcis|

v 1] DLE B X NI A @ LE “Unreferenced”

v A8 S i Modeli#E A Sizing=> Scoped, BOIX ~| H 3 € X {Fsizing
scope[f] X

— 1D
ke
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ANSYS

R

A=k

> R E

v BT RS 2142 1) 1 7 A, T BB DX s B A S R

v g “Write” 5 ANRSTRREGFm 4N “worldcar_target.szcontrol”

— 1D

f R A el AR

Scoped Sizing List

Scoped Sizing

boi_full-1

boi_up

boi_up

boi_up:

boi_up:

boi
)

|

m

=] [&] Global Scoped Sizing

Min Max Growth Rate

|o.5 |1024 |1.2

Local Scoped Sizing

Mame Tvpe

| control-1 | | curvature

Face Proximity Option

in Max

["|Face Boundary
[V|Face Face

Growth Rate  Mormal Angle [ J1anore self

[ e

Cells Per Gap
3 [a]
(&3]

Scope

Scope To |Object Faces and Edges A

Object Type

ey

Selections

| create | [Modify |

Delete | [Write... ] [Read.

]

[ Compute ] | Filters...

| | Delete Size Field | [ Close ] [ Help

“IDAJ-China 2 ANSYSH E R {24 & fE kL™
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ANSYS = R B = R Ab B B TAE AR

m HIARIZAT
> AT A T E AR R B4 scheme XU AT 17 bin SCA4:

AdvWrapNPrisms_Rxx_Userlnputs.scm < > R A SO 5
AdvWrapNPrisms_Rxx_v814 AdvSettings.scm «—— @i/t ER BRI HEE
AdvWrapNPrisms_Rxx_v814 Run.scm « > FASREITHIA ST 4
AdvWrapNPrisms_Rxx_v814 Main_Load.scm <«———»Userinput#ladvsettings 2@ X 32 #1055

A

-l A

5. AdvWrapNPrisms_Rxx_v814 Main.bin < > SEAMRARE UL RE LI 3 R TE AR

> IR sA e R UserinputFlAdvsetting 75 B & SO T4 N\ B 1K Ui
> HRPIB3A XA E NS

L)
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ANSYS

CAEURAE

B JHAREAT
> )\}\schemeIftFEF'i‘E1 ST

E%IJZIKI#%UE
> BATRAL 7 RSN, EEWER O EROT B RS R

AN Z (define compute size_field “no”) »

MAWZ R EN “yes”

AN RARARS HY RS )

> (define initial_over_target_size_ratio X)7E1X B 1] L g X 4R <1 %

¥ i A T A R D A B AL R A

L)
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ANSYS = R B = R Ab B B TAE AR

B A BN
> FTH“AdvWrapNPrisms_R16R17 v814 Userlnputs.scm” I 4s

TUSER INEUIS

(definel input_geometry " ") I

;If entered <name>, or <name.msh.gz>, it will read <name.msh.gz> and zip (.msh.gz) all cutput mesh files.
entered <name.msh>, it will read .msh and write unziped (.msh) all cutput mesh files.

;If C: drive is full, set the system environment variable "TEMP" to point to a drive that has enough space.

geometry>-initial.sf for wrapping and <input_geometry>-target.sf for surface remesh
;If yes, it will compute size field using <input_geometry>-initial.szcontrol for wrapping and <input geometry>-target.szcontrol for surface remesh.

(define] initial over target_size_ratic 0) I

;If initial_over target_size_ratic 1s set as 0, it will compute <input geometry>-initial.szcontrol for wrapping and <input_geometry>-target.szcontrol for surface remesh.

;If initial over target_size_ratic is set as 1, it will compute <input_geometry>-initial.szcontrol for wrapping and surface remesh.

;If initial over target_size_ratic is set greater than 1, it will compute <input geometry>-initial.szcontrol for wrapping and use initial over target_size_ratic * <input_geometry>-initial.sf for surface remesh.

s IMPORTANT: For complex models, the initial size cannot be too different from target size -- surface remesh cannot properly "walk over™ small details. Keep the factor below 2.0.

v BN U478 “worldcar”
v E SRR “yes”

v Initial_over_target_size ratioto “0”

L)
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ANSYS T R BEZE L A Ab H
NNy

> EIX BIRATREAL AT R AHR, FHLESREH 2 8)F -1
BRAEEHE, Bl lexternal it &, fanXt %, tunnelZs

(define sharp angle object_list '(air_channels external fan))

;List objects that require better feature capturing between their face zones. Examples:
1. (define sharp angle cobject_list ' {aero))

;2. (define sharp angle_ocbject_list '({aero tunnel))

;3. (define sharp angle object list " ()}

;4. (define sharp angle object _list "(#*)) --> all objects

:This operation will force the sharing wrapper nodes onto the geomeLry.

>EL£&MEXﬁ% FFAIE I H A NI AN B e
N RAT

(define dirty objecta '())}

:List dirty cbkjects that need automatic leakage detection and closure.

;Format: (define dirty objects '({{"object” leakage size threshold))) --> it will close all leakage smaller than leakage size threshold
;Example: (define dirty objecta '({("engine™ 1&) ("trans" 32)})

;1L there is not leakage, enter: (define dirty objects '"())

L)
Y/ AY “IDAJ-China BANSYSHEIR B & fE L™
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ANSYS

-y R =W

LN g

> BN B RRHIE X %44, il hair_channel, external, fan

(define

sharp angle object_list

"{air_channels external fan))

"{*}) —> all ckjects

rList cbjects that require better feature capturing between their face zones. Examples:
1. ({define sharp angle object_list " {aero))

;2. (define sharp angle object_list " ({aeroc tunnel))
;3. (define sharp angle object list "({})

;4. (define sharp angle object_list
rThis operation will force the sharing wrapper nodes ontoc the geometry.

AR S e R
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> BASRBE TR 2 F 7 EAE AN AR A

B 2 A REREAN AT

(define dead regions '())

;O0ther way to close holes is to provide
sFor example, there is no single region
;It will antomatically detect and clase
sEach material point must be entered in

a material point inside.
defining the cabin of a car. If you don't want any tet mesh inside
holes from these material points to the main fluid region.

quotes like: (define dead regions ' ("oll_pan" "cabin"})

;If there are no such dead zones and if you are not expecting any leakages,

enter: (define dead regions

B

Thi=s i=s useful if there are not a single object defining that region.

the cabin, enter a material point inside.

')

> FAGRAL 1 AR E AL YRR B

L

(define live regions ' ("main fluid" "mrf"))

sList all the material points for regions in which you want to put tet/tet+prism mesh

[liwve)

> FATRAE T MR AR /57X

(define wvolume fill regions '(("main_fluid™ priasm tet) ("mrf" no_prism tet)})
;These are the material points in which volume mesh to be generated. Examples:

; (define wvolume_fill regions "({("fluid main" prism hexcore) ("fluid rims™ no_prism tet)))
;"fluid main™ will have prism layers and volume-filled with hexcore.

rHote: avold creating hexcore in thin regionas.

==3

"fluid fan™ will NOT have prism layers and will ke wolume-filled with tet.

> BANRM T R R A,

XANEH T

"first height and last ratio"

H global prism layer settings

(define PrismLavyers :)

(define prism layer method "aspect ratiao") renter "aspect ratio" or

(define last_ratio percentage =0) ;used for "first height and last ratio"
(define prism layer first height .0254) fused for "first height and last_ratio”
(define PrismAspectRatioc &) ;used for "aspect_ratio”

(define PrismlayerGrothRate 1.2) sused for "aspect_ratio” and "uniform”

or "uniform"™

and "uniform™

— 1D

AR S e R
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ANSYS = R B E R B Ab B B TAE AR
m P AR
> T NBRAT AR EA ﬁﬁ']mam _fluidF AR+ R S

{deflnelwrap regions '("main_flui
rList all the material points for regions in which you want to put tet/tet+prism mesh (liwve)

 BATRAAER R R F R, FEMRFH I8 YA #.oo

(define|volume £ill regions '(("m

in fluid" prism tet) ("mri”

no_prism tet)))

:These &
; (define wvolume_fill regions '{{":luld main™ prism hexcore) {"fluid_:ims" ﬂc_p:ism tet))) ==
;"fluid main™ will have prism layers and volume-filled with hexcore. "fluid fan™ will NOT have prism layers and will be wolume-filled with tet.

sMote: avoid creating hexcore in thin regions.

» AV e /il A R BCE,  HLIE T 4 il

H global prism layer settings
(define| PrismLayers Z2)
(define|prism layer method "aspec ;enter "aspect ratio" or "first height and last ratio" or "uniform"
(define|last ratio percentage <0} ;jused for "first height and last ratio"

(define|prism layer first height .0252) ;jused for "first height and last ratio" and "uniform"
(define| PrismAspectRatio 5) ;used for "aspect ratio®
(define| PrismLayerGrothBate 1.2) sused for "aspect ratio” and "uniform"

> RAFscheme X A

L)
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PLZE X FE 1]

H Parallel Solid Meshing Journals and Bat file.
(define solid_meshing a™) ;enter "yes"™ if solids to be meshed. They will be wrapped from outside.

(define solid_meshing number of_ cores smumber of cores to be used for solid meshing.

(define solid resolution factor ;gize field for surface mesh of solids = solid_resoclution factor * target.sf
(define solid_meshing max_skew ;target skewness for solids

(define solid_meshing volume "yes ") renter "yes" if you want wolume mesh, enter "no" if you want only surface mesh.
(define solid meshing R1§ 1n5t,allat,1cun . path "C:\Fr a4\ flu exe™)

S\ANSYS Inchvi70\

,:L'xstallatlc'x path for the bat file.
;Usage: Right after size function is created, a .bat file is created. Double-click on .bat file to start meshing the so0lids.
H parate contact pairs

(define fluid fluid distance_scaled tolerance
(define other angle tolerance
(define other_distance_scaled tolerance

(define seprate neighbors arcund ff pairs "o ) ;renaming adjacent zones for fluid2fluid mesh interfaces and they (_ff pairs neighbors-+)
;Usage: (1) change zone type to non-walls (e.g. symmetry) if you don't want them paired (example: heat exchanger sides),

; (2) type: separate contact pairs, (3) to setup mesh interfaces in the solver load out_solver f2f set nci.jou.

;Mapping (fluid:solid, and solid:solid journals and.csv files will also be created.

(define fluid fluid angle_tolerance o) ;separate contact faces between fluids if angle between them is less than this value (degrees)
) :rseparate contact faces between fluids if scaled distance between them is less than this walue
;separate contact faces between fluids and solids and between solids and solids (for mapping) if angle between them is less than this value
;separate contact faces between fluids and solids and between solids and solids if scaled distance between them is less than this value
(define separate_ring around ff pairs "no") sseparating a ring of faces outside the fluid2fluid mesh interfaces and they (_ff pairs_ring-*) will be excluded from mesh adaptation.

wWill be excluded from mesh adaptation.

(degrees)

L)
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51 1 BLEXBOIN B

LDVANCE SETTINGS

(define
(define

i

1)

(define
(define
(define

(define

exclude zones "tunnesl*")

zones_to_offset ' (

;Refinement Zone
;Region Nams List

(" _boi_full® man

upstream boi min size 32)
upstream boi_levels &)

upstream boi_height 2 expansion ratio 1.2)

RefinementRegionGrowthRate 1.5)

user input for refinement regiomn

BL
Height

BL BL Wake Total
Divisions Min SF Expansion

Factor

[
r

During size controls definition, type: generate_bois

_____________ end user input for refinement regions

Wake
Divisions

Cross-Wake
Total Expansion
Factor

)

wn

— 1D

£

AR S e R
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; Wrapping Settings
(define exact node projection "no™)

;only in rlé

(define size adaptation factor 1)

;Initial wrapper will be coarsened by aize adaptation factor before imprint. This will lead to faster imprint and final remesh.
;The larger this factor the more loss of features during imprint.

(define aize_adaptation
(define skinning type "
:"shadow™ or "skin"
(define size_ adaptation conly on_gecm "no”)
(define objects_with gaps '())

;Enter object name, max size.

a7)

)

SK

;Format: (define objects_with gaps ' (("object_namel” max gap size_to_coverl) ("object name2" max gap size_to_cover?) ... ("object_namen"™ max_gap size_ to_covern)))
;Max _gap 3ize to_cover: max gap 3ize. This is the size at which wrapper will cover all the important gaps.

;Example: (define objects_with gaps ' (("ext™ )))

;1f plan is not to cover those gaps, enter: (define objects_with gaps '(})

(define aeparate_sharp_angle "no”)

;3et to "no" for complex geometry

(define sharp angle separation_angle 40)
;feature cleanup

(define size adaptation using_ target size
(define merge overlapping edges "ves™)
(define feature merge_factor 0.
;any features that are in proximity to each other within feature_merge_factor * local_ size field, it will be merged. After merge it leads to faster imprint and remesh.
(define coaraen by remesh features_after_delete overlapping_edges "no™)

(define edge curvature_growth_rate Z)

(define edge curvature_rate 10)
(define merge lows "ye3")
(define high wrap live_regions
;only used for wersion 15.

") ; If yes, it will lead to loss of features, but is faster (~20%)

(define standard low wrap
(define standard inner wrap
(define coarsening_curvature_angle
;rused for coarsening and remeshing of surfaces that don't have any feature edges defined.
:The smaller this number the more curvature will be captured, but with reduced quality.

; End Wrapping Settings
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H eature Capturing
(define no_of imprints_off geom 1)

(define no_of_imprints_on_geom Z)

(define no_of_rezones_for sharp_angle cbject 1)
(define no_of_rezones_for sharp_angle object_skinning 1)

(define feature threshecld tel_rest I)

(define feature cleanup tol off geom 2)

(define feature threshold tol off geom )

(define feature_cleanup_tol_on_geom [.5)

(define feature_thresheld tol_on geom 0.5)

(define sharp_angle capturing_£ Dd_ﬁkinning_nf_di rty_cobjects "no”)

(define off_geom relative_dist imprint 0.1)
(define off geom angle_imprint 30)

(define off geom ring imprint 2)

(define on_geom imprint_after merge "no”)

H nd Feature Capturing
i urface Remesh
(define surf remesh method 0) ;enter 0, 1 or 2 (most robust and fast methed is 1)
{define surface remesh method 1-off geom coarsening factor 1.1)

(define on_geom surface_ remesh angle 40)
(define on_geom surface_remesh corner_angle
(define edge cleanup angle 40)
(define edge_cleanup_count 4)
(define off_geom relative_dist 0
(define off_ geom_angle 90)
(define off geom ring 1)

(define hybrid wrap "ves™)
(define alternating_gquad split_ for_wrapper "no”)
(define standard wrap_n_remesh "yesz")
(define off_geom_aggressive_ improve "v
(define coarsen using_ surface_remesh "
{define surface remesh curvature angle
(define surface remesh corner_angle &0)

H nd Surface Remesh

B urface Improve
(define contact_face_count )

;any contact face count less than & will be removed.
(define remove_sharp angle_global "ves")

(define remove_sharp angle_global_ iterations 1)

(define remove_sharp angle ignored base_aggressive_improve
(define remove_sharp angle_ ignored base_gentle_improve
(define remove_sharp angle_ignored base_iterations 1)
(define remove_sharp angle ignored base_smooth_only
(define min dihedral angle 16.0)

(define aggressive collapse_skew 0.9)

rcompulaive collapse of faces having skew larger than this value after all automatic options are exhausted

(define MaxFaceSkew [
;Faces that cause bad prisms will be separated. It will use this max skew value to collapse them.

(define MaxFaceSizeChange 1.5)

:Faces that cause bad prisms will be separated. It will use this max size change to collapse them.
(define max_island face_count 500)

;Island clusters are deleted if their face count is smaller than or egual toc 200.
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> ¥TJFFluent Meshing, H& ML RX#S SCAF AN EIAS SC AR AT RS A%
> i A\File=>Read=> Scheme

worldcar_sizin

g1l Fluent@punrvsonawapcwin.ansys.com [3D, serial]

File | Boundary Mesh Display Report View Help

Read Mesh...

Writ Case...

Import Boundary Mesh...

Save Picti Size Field...

Exit Scheme... I
Journa l...
Demains..

worldear_sizingl

waorldear
test_prism_bracket_solo_v3_surface
test_prism_bracket_solo_v3

[ Al

> Jz*ifx”AderapNPnsms R16R17_v814 Run.scm” BEIA A, ‘E¥H

ihis

v \
Fs
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> ¥THFluent Meshing
> 33t \File>Read=>Mesh
> N “worldcar_hx.msh.gz” (4t

> 1 A\to Mesh—>Create=>Heat exchanger

> ARG, AR R
> 1E“Heat Exchanger Mesh” THI# 1,

RN ENFRE R, R

> mi“Select nodes..” %41 1E

“Heat Exchanger Mesh” [k

worldcar_hx Flue

nt@punrvsonawapcwin.ansys.com [3D, serial]

File Boundary

RS- H

Mesh | Display Report View Help

Auto Mesh... El :k ﬂﬁ - - - -
Prisms... o M
Thin Volume Mesh...
Pyramids...

MNeon Conformals...
Tet...

Hexcore...

CutCell...

> EENRIEF3N FOF A R KT

Working

.\.
| Select 3 points to define plane and 4th point to grow prism...
4

Cancel

[s2]
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> IERFE R IE

> G AR RS

> BN SN

“worldcar_hx_mesh.msh.gz”

E Heat Exchanger Mesh tﬁj
Parameters By Modes
Location Node ID

Positian First Node bn7734382
Second Node
Create By bn7735006

nterya Third Mode ’m
Fourth Node [,,7720a53
Size in P1-P2

Select Nodes...

|

Size in P1-P3

T

Size in P1-P4
10|

| Create Object

I|Creahe || |Preview| | Close | | Help ‘

E worldcar_hx Fluent@ punrvsonawapc.win.ansys.com [3D, serial]

File Boundary Mesh Display Report View Help

@ - w@ [Fe QR S Q8- E 0B
=-§9 Mesh G‘eneration daliesty hd

c mety Ohjects
Draw
Draw Options 3
List Selection 3
Diagnostics 3
Merge 3
Rename/Change Properties...

, Objects Only |
Convert to Mesh Object I Include Faces And Edges I
Wrap 2
Remesh...
Advanced 3
CAD Association 3
Summary
“IDAJ-ChinaZ infe
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CAEAR

B IR World Cariib? ik
> K BRUAS A= Rl A o %
> A E: 30million
> MR FRE: 0.9599 (Orthoskew)

Wall-Clock Usage:

cowputed 3 in --------------------- - - - - - - - ————— 23,25 minutes (0.3875 hours).

Merge zones in ----—-——-—————————— 9.75 mimmtes (0.l1625 hours).

Wrapped all liwve regions in ------——--—-———————--——- 32,65 minutes (0.54416667 hours).
Merge in -—-————----————— 4. 533353353 minutes (0.075555556 hours).
Inprint in —----—-——-=-=—=——— 46,65 minutes (0.7775 hours).

Zurface Remesh to target size in —--—--—----—-—-—- 22.7333353 minutes ([0.37553589 hours).
Jurface Improved (inflate) in -----————----—-———- 5 minmates (0.083333333 hours).

turface Improved (general) in ----————----—-———- 13. 516067 minutes [0,22527778 hours).
Jurface Improwed (resolve_int) in -------------- .05 mirmtes (0.084166667 hours).
FostTet Surface Improwe in ------——————————————- 21.15 minuates (0.3525 hours).

Connect Meszh Objects with Wrapper ih ------—--—-—- G.2le6667 mitutes (0.10361111 hours).
Compute ¥olume-Fill Fegions in ----—--—--—--—————- Z.9166667 mitutes (0.045611111 hours).
Prizm= generated in ------—-———-————————— - ———— 35.1 mimmrtes (0.555 hours).

Prizm= Improwed [(Continuous) in ---—--——----—-———- 43, 5333353 minutes [(0.72555556 hours).
Fezoned in ---—----—-————— - 33.3833353 minutes ([0.55638589 hours).
Yolume-£ill in ----—-—— - 15.15 minutes (00,3025 hours).
TOTAL MESHING TIMNE: ——-----—e 342.53333 MINUTES (5.70585859 HOUES)

CPU-Time: Z2Z53.005843 min (4.7168072 hours)

| Wirtual Mem Usage (GE) |
I | Current Feak || Page Faults
serial | 23.92003 25.6975 || &.064e+05
Total| | 23.9008 25.6975 || 2. 064e+05
LY IDAJ-China e ANSY SR EX IS TR TR
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Scoped Parallel Prism + tet + lean data structure (beta)

12

10.55
10

8 7.6
4 6.4
= 5.8
s 6 47
=

a 3.8 3.83¢6 33

232523 262526
2 I
0
Combustor Landing Gear Oilplatform

M R16 -nolean M Serial W2-dpm ME4-dpm 8-dpm 16-dpm

Combustor Landing Gear Oil platform
4.7 M Prism 7.0 M Prism 3.6 M Prism
3.5 M Tet 5.7 M Tet 5.7 M Tet
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> AT RN AR R AT R 2 AT R 2.3 N AF S [RI nik

2-3f%

Auto Identify Volume
Object

e <) (zen)

Keep Solid Cell Zones

Boundary Layer Mesh

Grow Prisrns' [sr.:oped v] Set...

Quad Tet Transition

(@ Pyramids
() Non Conformals

Volume Fill

Options

Merge Cell Zones
Auto Identify Topology

(] (s

Auto Mesh ‘ M

Poly

Options Poly Zones

Merge Free Nodes Non-Fluid Type
Delete Unused Nodes dead —
[ improve Surface Mesh
Improve Poly Mesh
Cell Size

Max Cell Volume {Apprax)

232,1002

Cell 5izing

L&

size-function -

Mo active poly refinement regions.

[Create] [Apply ] [Close ] [ Help ]

P e
Local Regions... o= =
b
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— 8.1 million poly cells
— R16.1
e Worst initial 0S = 0.99

e Time = 32 min
* Peak memory 12 GB

. Worst OS = 0.9
. Time = 20 min
e Peak memory 12 GB

> o b P R T P R

—
§=‘
i
% gw
LH
CaH

3 cells over 0.9 fixed by ANM

0 -
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W ORRAS R IR TT S
»Coupled SolverERilXFHConservative Coarsening® ik
v B R SR
vOIREIR T T IS SR FH 22 THUAAR AR« DX ol 1 2 22 1A B A9
> A% B RS s SR il B B0 2 MR AE PR E T Reorder
v RIS S S SR
» FLUENTAE L7 TH — B e S F A BB, RITH—DF R H

*No reordering 1er02 *RCM reordering

*Not c.:onve'rged >200 tor00 eConverged in 94 iterations
1e+00 iterations 1
: Te-0z |
1e-02 il |7 1 .
] \J ﬁk 18-04

18-10

T T T T T ! T T T T T T T T T 1
0 50 100 150 200 250 300 0 10 20 3 40 50 60 70 80 90 100
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V' Steady # transient (fixed mesh), 3D F11 2D ~“F*[ff]

v RS IRIR A S
VAL R
v BN EL VOF Z AR A
v AR
v k-epsilon F1 SST k-w i Zh Y
v BETA: Bk AT RV TR 5K JIHIVOFRESY . pressure-far-field i1 5. Workbench SZ#f. 7Bz
BE SR
3 Create/Edit Overset Interfaces @ - B ,(T‘ 'IT ’f‘LJ{/‘F
Overset Interface JJFT?(» =
0sg ] Hl
E] Background Zones E] E] E] Component Zones E] E] E] %
osg part_8-background part_8-big-gear %

part_8-small-gear

[Creahe ] [Delehe ] [Delebe Al ] [Close ]

o PRAHI: S ]

A

I

e A HEFDBNS et RS

« A Z¥FNode-based gradients
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—Bounding Surfaces
bounded-by-surfaces Bounded Surfaces x| =| =|Imported Surfaces x| =| |
rotation clip-x-coordinate-4
scalmgl inlet
translation outlet
A ,
_— Read...| Display..
— 1 1 A\_ Create...l Deletel Renamel Applyl | — |

DS AT S
» Adjoint Solver & Design Tool
v Adjoint Solver>Z ¥ 1] B 11 &
v Design tool Ui
o MRARTE PR ] ThT ) SCHF
. T iz 3l (rotation, translation, scaling)

o IE G M- 4R
o STL#iH

—Design Conditions
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v YRR HH [FICFX, Fluent and Mechanical 43 #7301 H i@ i System

Coupling#i &

v S FluentfIFluentiB i System Couplingfi &

. Geomefry

2 ) Geometry "

Geometry

- B - C - D hd E
B rusren iy I = o B rusron e I = ovenconi
2 ) Geometry v 4 2 & EngineeringData 2 i) Geometry v 4 2 @ setup v o4
O sl vy (e /[ Ei—
4 @ Setup v 4 4 ﬁ Model v 4 4 @ Setup v . System Coupling
5 [E solution v . 5 @ setup v 5 |[E solution vy
6 @ Results &, 6 [E solution v 6 @ Results &,

fluid1 7 @ Resuls = fluid2

Static Structural

/

7w
~ 11

Two Fluent and one Mechanical system connected via System Coupling
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' Fluent Launcher \i/\ﬂ/\ﬂ/

Fluent Launcher

/Ll

Dimension Options
_. 20 Double Precision
Q 3D D Meshing Mode

D Use Job Scheduler

Display Options D Use BRemote Linux Modes

D Display Mesh After Reading

D Embed Graphics Windows Processing Options
Workbench Color Scheme () Serial

@rallel ({Local Mac@

 MAXIMIZE YOUR ANSYS®

FLUENT® PRODUCTIVITY WITH
DIA® GPUs

GPGPUs per Machine
1 2

# Show More Options

l 0K l l Default ] [ Cancel ] l Help 'l
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> GPUFIL T 111million %S5 f1 5 [a) /5
Il 144 CPU cores

ruck Body Model

111M mixed cells

External aerodynamics
Steady, k-g turbulence
Double-precision solver

CPU: Intel Xeon E5-2667;
12 cores per node

GPU: Tesla K40, 4 per node

*Fluent solution time
* per iteration (secs)
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*ANSYS 17.0

*1.8M cells -
8 Cores (Xeon E5-2687) A3
*64 GB Ram
*NVIDIA K40 GPU iz —
*Solution Time: .

e GPU:~1hr /.) e

No GPU: ~ 1.75 hrs

*GPU Produces a 43% Reduction in Solution Time
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